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CHAPTER 9 l Examples
In this chapter we take you step by step through the 
procedures we used to build three models in the 
TriSpectives catalogs. These models — the bar stool, the
hammer, and the cellular telephone — feature the 
following TriSpectives tools and techniques, if you’d like
to learn more about them by seeing them in action:
· Creating 3D custom shape tools from 2D cross-
sections
· Creating hole shapes with 3D custom shape tools
· Copying shapes
· Creating mirror images of shapes in the 2D cross-
section
· Positioning with SmartSnap
· Precise positioning of copied shapes with the TriBall 
tool
· Precise positioning with SmartDimensions
In the first two model-building procedures, you’ll create 
several
2D cross-sections and 3D custom shapes. In the last 
model, the telephone, you’ll use many of the positioning
tools in TriSpectives.

In this chapter
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· Building a bar stool
· Building a hammer
· Building the body of a cellular telephone

ž
ž
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lBuilding a bar stool
The bar stool model consists of three main shapes: the 
seat, the legs, and the footrest ring at the bottom. The 
seat and legs are 2D cross-sections that TriSpectives 
extends into 3D. The footrest ring is a torus shape from 
the Shapes catalog.
In the following procedures you’ll build these shapes 
and position them to create the bar stool model. When 
you’re done, it looks like the model in the Showcase 
catalog and the following illustration:

Finished bar stool model from Showcase catalog

Preparation
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Before you start building the model, take these steps:
1 Create a new scene in your WorkBook.

· If TriSpectives is open but you don’t have an 
open WorkBook, choose New from the File 
menu. Select 3D Scene in the WorkBook 
Wizard and then select Finish.

· If you have an open WorkBook, choose Scene 
from the Insert menu. In the resulting Insert 
Scene dialog box, choose As New Scene in 
WorkBook, and then choose OK.

1 If they’re not showing already, open the 2D 
Drawing toolbar and 3D Shapes toolbar.

Select Toolbars from the View menu. In the resulting
dialog box, check the boxes next to 2D Drawing and 
3D Shapes, and then choose OK.

Custom shape tools 2D Drawing toolbar

3 Show measurements for your 2D cross-
sections, and make the measurements in 
centimeters.

Select Options from the Tools menu and then:
· Click the 2D Drawing tab. In the ensuing 

properties sheet, click the check box next to 
Show Snap and Measurement Feedback.

· Click the Units tab. In the next properties sheet, 
select Centimeters in the Length field and then 
click OK.

Beginning the seat shape
To begin the bar stool, create the seat. Use the 3D Spin 
Shape tool.

u To begin making the seat of the bar stool:
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1 Select the Edit IntelliShapes tool.

2
3 Select the Spin Shape tool on the 3D Shapes 
toolbar.
3 Click in the scene and then select Finish on the

Spin Shape Wizard.
TriSpectives displays a grid and the Edit Cross-
Section dialog box. You’ll use the grid to draw 
the 2D cross-section of the seat.
Make sure the vertical axis of the grid is on the 
left.

Tip: Drag the dialog box out of the way so it doesn’t 
interfere with your work on the grid. You should also 
select the Look At tool and then click the grid to view
it straight on.

4 Change the grid settings to create a finer 
network of grid marks.
Right-click the scene background, select Grid 
Settings from the pop-up menu, enter 1.5 as the 
vertical and horizontal grid line separations, and 
then click OK.

5 Use the Zoom Camera tool to close in on the 
grid until you feel you can draw on it 
comfortably.
You’re ready to draw the 2D cross-section that 
TriSpectives will spin into a seat. 

Creating the seat cross-section
The cross-section for the bar stool seat consists of a 
series of lines and arcs. To make sure the lines and arcs 
form a continuous cross-section, begin each 2D shape 
by clicking in the same spot you clicked to end the 
previous 2D shape. 
When you’re over this spot, a green dot appears. If you 
don’t use the green dot, your lines will be discontinuous 
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and TriSpectives will be unable to extend the cross-
section into 3D.
As you use the next few steps, refer to the following 
illustration of the completed cross-section for 
assistance.

u To draw the 2D cross-section:
1 Select the Line tool and create your first line.
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Move your mouse pointer to a grid line on the 
vertical axis near the top of the grid. Click and drag 
a straight line to the right. When TriSpectives reports
that you’ve moved 18 cm from the vertical axis, click
to end the line. Because you set the grid line 
separations at 1.5 cm, your line should span 12 
squares.

2 With the Line tool still active, connect a 
second line to the first.
Move your mouse pointer to the spot where you 
ended the first line. When the green dot appears, 
click and drag the mouse straight down. When 
TriSpectives reports that the straight line is 7.5 cm 
long (5 squares), click to complete it.

3 Select the Arc tool and draw a series of five 
connected arcs directly under the second line.
Move your mouse pointer to the spot where you 
ended the second line. When the green dot appears,
click and drag to define the first arc. 
Repeat this step to make the remaining arcs. Each 
arc should be 1.5 cm long (1 square) with their 
crowns facing right. In the next two steps you’ll flip 
some of them to create a ridged effect.

4 Select the Arc tool again to turn it off.
5 Flip the second and fourth arcs to make the 

five arcs form a curved ridge.
When you turn off the Arc tool, a square handle 
appears in the center of each arc. On the second 
and fourth arcs, drag this handle to the left to 
reverse their orientation. Release the mouse when 
the revised arcs are the same size as the other ones.
When you’re done, the arcs should face left, then 
right, then left, and so on, as shown in the following 
illustration.

6 Select the Line tool and create a line that 
connects the endpoint of the bottom arc to the
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vertical axis.
Move your mouse pointer to the spot where you 
ended the last arc. When the green dot appears, 
click and drag to the vertical axis. When you’re over 
the axis, click to end the line.

7 Select the Fillet tool and round the corner in 
the juncture of the lines you created in Steps 1
and 2.
With the tool on, click the juncture, then drag down 
and to the left. When you’re done, the cross-section 
should look like this:

Finished cross-section for seat of bar stool

8 To turn the cross-section into the seat of the 
bar stool, select Finish Shape in the Edit Cross-
Section dialog box.
The seat appears. Next, you create the legs of the 
bar stool.
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Beginning the leg shape
In this procedure you’ll use the Sweep Shape tool to 
create a leg for the bar stool. The sweeping procedure 
has two parts: first you create a cross-section to 
determine the first two dimensions, and then you create
a path that TriSpectives uses to sweep the shape into 
the third dimension.
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u To make a leg of the bar stool:
1 Use the Orbit Camera and Look At tools to 

look straight at the bottom of the seat.

2
3 Choose the Select tool and then choose the 

Edit IntelliShapes tool if it isn’t selected 
already.

4
5 Select the Sweep Shape tool on the 3D 
Shapes toolbar.
4 Click in the scene on the seat, near its edge.

The seat appears in green highlight when the 
pointer is over it.

5 On the Sweep Shape Wizard, make the 
following selections:
· On page 1, choose to sweep the new shape Away

from the seat. Select Next to move to page 2.
· On page 2, choose a Straight line as your sweep 

path. Select Next to move to page 3.
· On page 3, choose to Add material to the seat, 

and then select Finish on the wizard.
TriSpectives displays a grid and the Edit Cross-
Section dialog box. You’ll use the grid to draw 
the 2D cross-section of the leg.

Tip: Drag the dialog box out of the way so it doesn’t 
interfere with your work on the grid. You should also 
select the Look At tool and then click the grid to view
it straight on.

6 Change the grid settings to create a finer 
network of grid marks.
Right-click the scene background, select Grid 
Settings from the pop-up menu, enter 1.0 as the 
vertical and horizontal grid line separations, and 
then click OK.

7 Click the Circle tool, move the pointer to the 
grid, and draw a circle with a diameter of 4 
cm.
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Click at the origin of the grid and drag to form the circle.
Release the mouse when TriSpectives reports that 
the radius is 
2 cm.

8 Choose Finish Shape on the Edit Cross-Section 
dialog box.
TriSpectives displays a second grid, this time 
along the path. You also see the Edit Sweep Path 
dialog box.

Use the Orbit Camera tool to change your view and 
look at the seat from the side. The grid should 
appear to be parallel with the scene. To turn off the 
Orbit Camera tool, click on it again.

9 Adjust the line separations in the grid to 5 cm.
Right-click the scene background, select Grid 
Settings from the pop-up menu, enter 5 as the 
grid line separations, and then click OK.

10 Create the first line of the sweep path.
Click the red handle at the end of the sweep path 
line and drag the handle away from the seat. When 
the line is 60 cm long, release the mouse. If you 
reach the edge of the scene before the line is long 
enough, use the Zoom Camera tool to make your 
vantage point seem farther away.

11 Click the Arc tool and add an arc to the end 
of the sweep path.

Move your mouse pointer to the spot where you ended 
the line. When the green dot appears, click and drag
away from the seat to define the arc. Release the 
mouse when the arc is 15 cm long.

12 Select the Arc tool again to turn it off, and then
revise the shape of the arc.
To reshape the arc, drag it by its square and round 
handles. When you’re done, the arc should still be 
15 cm long. The endpoint of the arc should sweep 
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away from the main line by 
5 cm (one square). 
The sweep path should look like the following 
illustration.

13 Choose Finish Shape on the Edit Sweep Path 
dialog box.
TriSpectives moves the circle along your sweep path
to create the bar stool leg.

Sweep path of bar stool leg

Positioning the leg on the seat
Use the TriBall tool to position the first leg under the 
seat of the bar stool. When you like the first leg, you’ll 
copy three more and position them with the TriBall as 
well.

u To position the bar stool leg with the TriBall tool:
1 Use the Orbit Camera tool to rotate the bar 
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stool and make it seem upside down.
Stop rotating when you can see a sizable portion of 
the bottom of the seat. You’ll use this surface to 
position the leg.

2 Choose the Select tool and then choose the 
Edit IntelliShapes tool if it isn’t selected 
already.

3
4 Select the leg and then select the TriBall tool.

The TriBall tool appears over the leg.

TriBall tool

4 Drag the leg until it is just inside the edge of 
the seat.
Place your mouse pointer in the 2D plane on top of 
the model. This plane is shown in the preceding 
illustration. When the pointer becomes four straight 
arrows, you can drag in a 2D plane along the seat 
bottom. Drag the leg into position.

5 Rotate the leg until its sweeping side faces in 
the opposite direction from the seat.
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To rotate the leg, click the 1D handle above the 
plane you just moved. The handle is shown in the 
preceding illustration. When the axis of rotation 
appears in yellow, move your pointer inside the 
TriBall. When the pointer changes to a hand and 
arrow, drag the leg around the axis until the sweep 
faces away from the seat.

You might need to use the Orbit Camera tool and view 
the model from several angles before you can rotate 
the leg into the perfect position. The Orbit Camera tool 
and the TriBall work in tandem, so you don’t have to 
turn one off to use the other.
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To help with the previous step, you can try the 
following:
Turn off the TriBall, select the leg, then right-click it and 
select Edit Path from the pop-up menu. When the path 
grid appears, select the TriBall tool again, then select 
the axis of the TriBall that is perpendicular to the seat 
bottom. Next, select the seat bottom on a point that’s 
outside the TriBall, and use the Look At tool to view the 
bottom surface directly. Finally, use the TriBall hand and
arrow to rotate the leg until the sweeping portion is 
radial. When you’re done, select Cancel from the Edit 
Path dialog box.

Copying and positioning the other 
legs
When you’re satisfied with the position of the first leg, 
create copies of it.

u To copy the other legs:
1 Choose the Select tool and then choose the 

Edit IntelliShapes tool if it isn’t selected 
already.

2 Right-click on the table leg and then drag it 
along the underside of the seat toward the 
opposite edge.
The precise placement of the leg isn’t important at 
this point. 

3 Release the leg when you get close to the 
opposite edge.

4 From the pop-up menu, choose Copy Here.
Now the bar stool has two legs. The second leg 
appears where you released the mouse.

5 To position the second leg, repeat Steps 3 
through 5 of the procedure in the previous 
section.
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6 Use the steps above to copy and position two 
more legs.

When you finish, the model should look like the 
following illustration. The next two sections show you 
how to finish the model.
Note: If you’d like examples of copying and positioning 
according to specific distances, see “Using the TriBall 
for precise copying” and “Using SmartDimensions for 
precise positioning” in the final model-building example
of this chapter.
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Bar stool in progress

Creating the footrest ring
The last part of the bar stool model is the ring near the 
bottom, where patrons rest their feet. Unlike the first 
two shapes, you can drag this one out of the Shapes 
catalog.

u To add the footrest ring to the model:
1 Select the Edit IntelliShapes tool if it isn’t 

selected already.
2 Click the Shapes tab at the right of the window

to see the items in its catalog.
3 Drag the Torus shape from the catalog and 

drop it on the model.
Release the mouse when one of the bar stool legs 
appears in green highlight.

4 Change the dimensions of the torus shape to 
make it fit the model.
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Use the shape’s Sizebox properties. Right-click the 
torus, select IntelliShape Properties from the pop-up 
menu, and click the Sizebox tab. 
In the Sizebox properties sheet, change the height, 
width, and length of the torus to 44 cm each. Click 
OK when you finish.

In the next series of steps, you change the diameter of 
the torus ring.

u To change the diameter of the torus ring:
1 Right-click the torus and select Edit Cross-

Section from the pop-up menu.
TriSpectives displays a grid and the Edit Cross-
Section dialog box.

2 Adjust the line separations in the grid to 4 cm.
Right-click the scene background, select Grid 
Settings from the pop-up menu, enter 4 as the 
grid line separations, and then click OK.

3 Click a square handle on the torus cross-
section and drag until TriSpectives reports 
that the radius is 2 cm.

4 Choose Finish Shape on the Edit Cross-Section 
dialog box.

Next, position the ring on the stool. Again, use the 
TriBall.

u To position the footrest ring:
1 Use the Orbit Camera and Zoom Camera tools

to look down the legs of the bar stool and see 
the seat bottom.
Tip: To position the ring, it might help to see the 
shape’s underlying geometry. Right-click the scene 
background, choose Scene Properties from the pop-
up menu, and then click the Rendering tab in the 
resulting dialog box. In the next dialog, select 
Wireframe style and click OK. If you prefer the 
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default setting, repeat the steps and select Realistic 
Shading.

2 Choose the Select tool, select the footrest 
ring, and then select the TriBall tool.
The TriBall tool appears over the ring.
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3 Rotate the ring until it’s perpendicular to the 
bar stool legs.
To rotate the ring, click the 1D handle at the side of 
the ring. When the horizontal axis of rotation 
appears in yellow, move your pointer inside the 
TriBall. When the pointer changes to a hand and 
arrow, rotate the ring. Because the ring started in a 
vertical position, you should rotate it 90 degrees to 
make it horizontal.

4 Drag the ring until it encircles the four legs 
and intersects them where the arcs of the legs
begin.
Place your mouse pointer in the 2D plane parallel to 
the plane of the torus. When the pointer becomes 
four straight arrows, you can drag within the 2D 
plane to reposition the ring.
Finally, move to a side view of the torus. Push or pull
on the handle at the end of the torus’ vertical axis to
adjust its height along the legs.
You might need to use the Orbit Camera tool and 
view the model from several angles before you can 
drag the leg into the perfect position. The Orbit 
Camera tool and the TriBall work in tandem, so you 
don’t have to turn one off to use the other.

Adding colors and textures
Now that the model is done, all you have to do is apply 
colors and textures. The seat looks nice with a shiny red
finish. Give the legs and ring a steel finish.

u To add colors and textures to the model:
1 Switch to Model mode.

If the Edit IntelliShapes tool or Edit Surfaces and 
Edges tool is selected, click it off.
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2 Click the Metals tab at the right of the 
TriSpectives window to see the items in its 
catalog.

2 Scroll through the catalog items, locate Steel, 
and drag it from the catalog onto the model.

4 Switch to Surfaces mode by selecting the Edit
Surfaces and Edges tool.

5 Scroll through the Surfaces catalog items, 
locate Shiny Red, and drag it from the catalog 
onto a surface of the seat.
Repeat this step a few more times to apply the Shiny
Red finish to all surfaces of the seat.
When you finish, the bar stool looks like the 
following illustration:

Finished bar stool

224 TriSpectives user guide



ž
ž
ž

lBuilding a hammer
The hammer model is made up of four shapes, three of 
which you create using the 3D custom shape tools. In 
the following exercises, you’ll build the hammer by 
creating and combining these shapes:

· The shaft, which you create using the Spin Shape tool.
· The hammerhead, a combination of positive and 

negative 
cross-sections you make with the Extrude Shape 
tool.

· The flat striking surface, a cylinder from the Shapes 
catalog.
When you finish, your model will look like the hammer 
in the Showcase catalog and the following illustration:

Finished hammer model from Showcase catalog

Preparation
Before you start building the hammer, take these steps:
1 Create a new scene in your WorkBook.

· If TriSpectives is open but you don’t have an 
open WorkBook, choose New from the File 
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menu. Select 3D Scene in the WorkBook 
Wizard and then select Finish.

· If you have an open WorkBook, choose Scene 
from the Insert menu. In the resulting Insert 
Scene dialog box, choose As New Scene in 
WorkBook, and then choose OK.

1 If they’re not showing already, open the 2D 
Drawing toolbar and 3D Shapes toolbar.

Select Toolbars from the View menu. In the resulting
dialog box, check the boxes next to 2D Drawing and 
3D Shapes, and then choose OK.

Custom shape tools 2D Drawing toolbar

3 Show measurements for your 2D cross-
sections, and make the measurements in 
centimeters.

Select Options from the Tools menu and then:
· Click the 2D Drawing tab. In the ensuing 

properties sheet, click the check box next to 
Show Snap and Measurement Feedback, and 
change the Snap To distance increment to 
0.25. Click to remove the checks from the 
Grid, Geometry, and Angles boxes under 
Snap To.

· Click the Units tab. In the next properties sheet, 
select Centimeters in the Length field and then 
click OK.

Beginning the hammer shaft
To begin the hammer, create the shaft. Use the 3D Spin 
Shape tool.

u To begin making the shaft of the hammer:

226 TriSpectives user guide



1 Select the Edit IntelliShapes tool.

2
3 Select the Spin Shape tool on the 3D Shapes 
toolbar.
3 Click in the scene and then select Finish on the

Spin Shape Wizard.
TriSpectives displays a grid and the Edit Cross-
Section dialog box. You’ll use the grid to draw 
the 2D cross-section of the shaft. Make sure the 
vertical axis of the grid is on the left.

Tip: Drag the dialog box out of the way so it doesn’t 
interfere with your work on the grid. You should also 
select the Look At tool and then click the grid to view
it straight on.

4 Change the grid settings to create a finer 
network of grid marks.
Right-click the scene background, select Grid 
Settings from the pop-up menu, enter 1.0 as the 
vertical and horizontal grid line separations, and 
then click OK.

5 Use the Zoom Camera tool to close in on the 
grid until you feel you can draw on it 
comfortably.
You’re ready to draw the 2D cross-section that 
TriSpectives will spin into a hammer shaft. 

Creating the shaft cross-section
The cross-section for the hammer shaft consists of a 
series of lines and one Bezier curve. To make sure the 
lines and curve form a continuous cross-section, begin 
each 2D shape by clicking in the same spot you clicked 
to end the previous 2D shape. 
When you’re over this spot, a green dot appears. If you 
don’t use the green dot, your lines will be discontinuous 
and TriSpectives will be unable to extend the cross-
section into 3D.
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As you use the next few steps, refer to the following 
illustration of the completed cross-section for 
assistance.

u To draw the 2D cross-section:
1 Select the Line tool and create your first line.

Move your mouse pointer to the vertical axis near 
the bottom of the grid. When you’re over the vertical
axis, click and drag a straight line to the right. 
When TriSpectives reports that you’ve moved 1 cm 
from the vertical axis, click to end the line. Because 
you set the grid line separations at 1 cm, your line 
should span exactly one square.

2 Select the Bezier tool and create a line.
Move your mouse pointer to the spot where you 
ended the first line. When the green dot appears, 
click and drag the Bezier line up and to the right. 
Release the mouse when the line is 
1.75 cm above and 0.5 cm right of the previous 
line’s right endpoint. 
In the next step you’ll drag the handles of the line to
create the Bezier curve.

3 Select the Bezier tool again to turn it off and 
then create the curve.
When you turn off the Bezier tool, two square 
handles appear on the surface of the line. Drag the 
bottom square handle down and to the right to 
create the Bezier curve. 
Release the mouse when the square handle is about 
0.75 cm right of the bottom endpoint of the Bezier 
line and about 
1.5 cm below the top endpoint of the Bezier line. 
When you’re done, the Bezier curve should look like 
the one in the following illustration.

4 Select the Line tool and create a series of 
lines to complete the cross-section of the 
shaft.
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Move your mouse pointer to the top endpoint of the 
Bezier line. When the green dot appears, click and 
drag straight up. The line should be parallel to the 
vertical axis. When TriSpectives says the line is 16 
cm above the previous point and 0.5 cm closer to 
the axis, click to end the line.
Draw three more lines to complete the cross-section.
Use the green dot to ensure connected lines.
· From the top endpoint of the previous line, draw 

a line toward the vertical axis that’s 0.25 cm 
long. The line should be perpendicular to the 
vertical axis.

· From the left endpoint of the previous line, draw 
a line parallel to the vertical axis that’s about 
7 cm long.

· From the top endpoint of the previous line, draw 
a 0.75-cm line to the vertical axis. When you’re 
over the axis, click to end the line.

5 Select the Fillet tool and round the two 
corners in the juncture of the first and second 
lines you created in Step 4.
Use the Window Zoom tool to focus on this small 
area. With the Fillet tool on, click the junctures, then 
drag down and to the left from the first corner. From 
the second corner, drag up and to the right. When 
you’re done, use the Fit Scene tool to restore a 
complete view. The cross-section should look like 
this:
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Finished cross-section for hammer shaft

6 To turn the cross-section into the shaft of a 
hammer, select Finish Shape in the Edit Cross-
Section dialog box.
The shaft appears. Next, you create the 
hammerhead.
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Beginning the hammerhead
In this procedure you’ll use the Extrude Shape tool to 
begin making the cross-section of a hammerhead. After 
you create this shape, you’ll create a hole shape with 
the Extrude Shape tool to sculpt the hammerhead.

u To begin making the hammerhead:
1 Use the Orbit Camera and Look At tools to 

look straight at the top of the hammer shaft.

2
3 Choose the Select tool and then choose the 

Edit IntelliShapes tool if it isn’t selected 
already.

4
5 Select the Extrude Shape tool on the 3D 
Shapes toolbar.
4 Move your pointer over the top of the hammer 

shaft and release the mouse when a green dot 
appears in the center.
This ensures that the hammerhead is positioned in 
the center of the shaft.

5 On the Extrude Shape Wizard, make the 
following selections:
· On page 1, choose to extrude the new shape 

Along the end of the shaft. Select Next to 
move to page 2.

· On page 2, choose to Add material to the shaft 
and then select Finish on the wizard.

TriSpectives displays a grid and the Edit Cross-
Section dialog. As usual, drag the dialog out of the 
way so it doesn’t interfere with your work on the 
grid. Use the Look At tool to get a direct view of the 
grid. Use the Window Zoom tool to close in on the 
grid.

Normally, the hammer handle will be pointing up, and 
the origin of the grid will be centered on the end of the 
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shaft. In this case, you will be working on the screen 
entirely below the top of the shaft.
Leave the grid line separations at 1 cm, the setting from
the previous example. You’re ready to begin drawing 
the hammerhead.

232 TriSpectives user guide



Creating the hammerhead cross-
section
The cross-section for the hammerhead consists of a 
variety of lines, arcs, and Bezier curves. To make sure 
these shapes form a continuous cross-section, begin 
each by clicking in the same spot you clicked to end the 
previous 2D shape. 
When you’re over this spot, a green dot appears. If you 
don’t use the green dot, your lines will be discontinuous 
and TriSpectives will be unable to extend the cross-
section into 3D.
As you use the next few steps, refer to the following 
illustration of the completed cross-section for 
assistance. This is much like a sketch that a tool 
designer would use in creating a hammer.

u To draw the hammerhead cross-section:
1 Select the Line tool and draw a line of 2 cm 
along the end of shaft and centered on the shaft.

Because the grid spacing is 1 cm, this line should 
span exactly two grid cells.

2 Select the Arc tool and draw an arc from one 
end of the previous line, spanning 2.25 cm in 
the direction of the shaft and 0.75 cm away 
from the axis of the shaft.
Don’t worry about the initial shape of the arc. Select 
the Arc tool again to turn it off, and then refine the 
arc’s shape.
To reshape the arc, drag it by its square handles. 
When you’re done, the arc should be concave 
outward, as shown later in the illustration of the 
finished cross-section.

3 Select the Bezier tool and create a Bezier 
curve.
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The curve should extend from the free end of the 
previous arc to a point 6.25 cm farther away from 
the axis of the shaft. In the other direction, there 
should be no offset with respect to the starting point.
Select the Bezier tool again to turn it off. Next, 
manipulate the square handles near each end to 
match the curve shown later in the illustration of the
finished cross-section.
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4 Select the Line tool and draw a small line.
Because you’re creating a small line, use the 
Window Zoom tool to zoom in on the endpoint of the
previous curve. From this endpoint, draw a line that 
extends 0.25 cm farther along and 0.25 cm farther 
from the axis of the shaft. Select the Fit Scene tool 
to return to a longer view when you’re done.

5 Select the Bezier tool again and create 
another curve.
This curve extends from the end of the previous line 
10 cm back toward and across the shaft axis, and 
1.5 cm farther along the axial direction.
When you release the mouse to finish defining the 
curve, select the Bezier tool again to turn it off. Two 
square handles appear on the surface of the line, 
and round handles appear on the ends. Use the 
square handles to create a flat Bezier curve that is 
convex outward. If you need help, see the following 
illustration. 

6 Select the Bezier tool once more for the next 
curve, which extends from the end of the 
previous curve.
This curve extends 1.75 cm laterally from the shaft 
and 1.0 cm axially back toward the shaft.
When you finish defining the curve, select the Bezier
tool again to turn it off. Move the square handles to 
mimic the concave outward slope shown in the 
following illustration.

7 Select the Line tool, then make a line that 
extends 1.75 cm from the end of the previous 
curve and is parallel to the shaft axis.

8
9 To close the curve, select the Bezier tool 

again and create one last curve.
This curve extends 1.25 cm axially and 1.75 cm 
laterally.
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When you’re done, the cross-section should look like
the following illustration.

Finished cross-section for hammerhead

9 To turn the cross-section into a hammerhead, 
select Finish Shape in the Edit Cross-Section 
dialog box.
The hammerhead appears. 

10 Make the length of the hammerhead 4.5 cm.
Right-click on the hammerhead in IntelliShape 
mode, select IntelliShape Properties from the pop-up
menu, and click the Sizebox tab in the resulting 
dialog box. In the Sizebox properties sheet, enter 4.5
in the Length field and select OK.

11 Center the hammerhead on the shaft using the 
TriBall tool.
By using the Orbit Camera tool to examine the 
hammerhead, you’ll notice that it now extends 4.5 
cm from the center-line axis of the shaft. To center 
the hammerhead, you need to move it 2.25 cm.
First, select the hammerhead in IntelliShape mode 
and then select the TriBall tool. If necessary, use the 
Orbit, Pan, Zoom, and other Camera tools to improve
your view. These tools work while the TriBall is 
active.
Next, click the handle of the axis along which you’ll 
move the hammerhead. When the axis turns yellow, 
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drag the hammerhead by the TriBall handle until a 
distance measurement appears. Right-click the 
measurement, select Edit Value from the pop-up 
menu, type 2.25, and choose OK.
You have centered the hammerhead.

Next, you’ll create a negative hole shape that carves out
a section of the hammerhead. When positioned 
properly, the hole shape combines with the positive 
shape to finish the hammerhead.

Beginning the hole shape of the 
hammerhead
In this procedure you’ll again use the Extrude Shape 
tool. You can think of your hole-shape cross-section as a
“cookie cutter” which, when extruded from the top of 
the hammerhead, will cut away material to produce the 
desired shape.

u To begin making the hammerhead hole shape:
1 Use the Orbit Camera and Look At tools to 

look straight at the planar pounding surface of
the hammerhead.

2
3 Choose the Select tool and then choose the 

Edit IntelliShapes tool if it isn’t selected 
already.

4
5 Select the Extrude Shape tool on the 3D 
Shapes toolbar.
4 Move your pointer over the planar pounding 

surface of the hammerhead and release the 
mouse when a green dot appears in the 
center.
This ensures that the hammerhead hole shape is 
positioned in the center of the positive hammerhead
shape.
We could not have done this easily on the top, 
curved surface of the hammerhead. Furthermore, 
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although we want to position the hole extrusion grid 
above the hammerhead, by starting with a known 
plane we can position it precisely later with the 
TriBall tool.

5 On the Extrude Shape Wizard, make the 
following selections:
· On page 1, choose to extrude the hole shape 

Away from the surface. Select Next to move 
to page 2.

· On page 2, choose to Remove material from the 
surface and then select Finish on the wizard.

TriSpectives displays a grid and the Edit Cross-
Section dialog. Drag the dialog out of the way so it 
doesn’t interfere with your work. 

6 Select the TriBall tool.
The tool is active for the Extrude Cross-Section grid. 
We want to rotate the grid 90 degrees and then 
move it parallel to the shaft axis until it is just above 
the hammerhead.
First, click the handle of the axis along which you’ll 
rotate the grid. When the axis turns yellow, move 
the mouse pointer inside the TriBall. When the 
pointer changes to a hand and arrow, drag the 
TriBall to rotate around the axis. When an angle 
measurement appears, right-click the measurement,
select Edit Value from the pop-up menu, type 90, 
and choose OK.
Next, with the TriBall still on, choose the Look At tool
and point to a lateral surface of the hammerhead. 
This gives you a good side view of the extrude grid 
position. 
Finally, click the handle of the axis that’s parallel to 
the shaft axis, and then drag the grid until it is just 
above the hammerhead. The grid remains 
perpendicular to the plane of the pounding surface 
and to the axis of the shaft.

7 Use the Look At tool to click on the grid and 
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view it straight on.
Use the Window Zoom tool and other Camera tools 
to improve the view, if necessary.
The hammer’s pounding surface should be at the 
top of the scene and the claw should be at the 
bottom.

8 Extend the grid over the full top surface of 
the hammerhead.

Select the Project Edges to Drawing Grid tool and 
then click the upper surface of the hammerhead. 
The grid extends to cover the entire upper surface of
the hammerhead. To turn off the Project Edges to 
Drawing Grid tool, click it again.
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The outline of the top surface of the hammer is 
projected onto the grid as construction lines. You want 
to work slightly outside these lines to ensure that all 
material you want to remove is fully accounted for when
you create the hole shape.
Leave the grid line separations at 1 cm, the setting from
the previous example. You’re ready to draw the 
hammerhead hole cross-section.

Creating the hammerhead hole 
cross-section
Because you’ve already drawn two cross-sections to 
help create the hammer model, we’ll be as brief as 
possible in taking you through the steps of the following
procedure. As you move through the steps, keep these 
points in mind:

· To make sure you create a continuous cross-section, 
begin each 2D shape by clicking in the same spot 
you clicked to end the previous 2D shape. When 
you’re over this spot, a green dot appears.

· Refer to the following illustration of the completed 
cross-section for assistance.
Also be assured that even though you’re drawing a hole 
shape, the lines you draw for its cross-section are solid. 
They won’t disappear.
The following steps assume the extrude grid is oriented 
so the hammer’s pounding surface is at the top of the 
screen and the claw is at the bottom.

u To draw the hammerhead hole cross-section:
1 Select the Line tool and place your pointer 

0.25 cm below the bottom left corner of the 
hammerhead top.

2 Draw a line that extends 10.25 cm up and 0.75 
cm to the right.
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3 Select the Arc tool and draw an arc that 
starts from the top endpoint of the previous 
line and extends up 2 cm, beyond the surface 
of the hammerhead, and to the right by 0.5 
cm.
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Don’t worry about the initial position of the arc. To 
finish the arc, drag it by its square handles. If you 
need help, see the illustration of the finished cross-
section later in this procedure.

4 Select the Line tool and draw a series of five 
lines. 

The first three lines are connected to each other. To 
draw the fourth and fifth lines, you’ll return to the 
first line of this cross-section and start the lines from
there.
· Start the first line in this series from the top 

endpoint of the previous arc. Draw a 
horizontal line 2.0 cm long away from the 
hammerhead. This line is off the surface of 
the hammerhead.

· From the left endpoint of the previous line, draw 
a vertical line 13.25 cm down toward the claw
end. This line is left of the surface of the 
hammerhead, and ends below the plane of 
the hammerhead.

· From the bottom endpoint of the previous line, 
draw a horizontal line 2.75 cm to the right. 
This line is just below the plane of the 
hammerhead, and falls just short of the axis 
of the grid.

· From the starting point of the first line you drew 
for this cross-section, draw a horizontal line 
1.25 cm to the right, along the bottom line of 
the hammerhead.

· From the right endpoint of the previous line, 
draw a diagonal line 6 cm up and 0.75 cm to the 
right. This point too falls just short of the grid 
axis.

5 Draw a “mirror” line, which you’ll use to add a 
symmetrical duplicate on the right side of the 
cross-section you’ve created.
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With the Line tool still active, draw a vertical line 
straight up along the grid axis, starting from well 
below the edge of the hammerhead. End the line 
above the top edge of the hammerhead plane, so 
that the mirror line bisects it.

6 Click the Line tool again to turn it off, and 
then choose the Select tool.

7 Right-click on the mirror line and select Use 
Outline for Construction Only from the pop-up 
menu.
This step eliminates the mirror line from being 
extended into 3D. You’re only using it to construct 
the cross-section.

8 Select the first shape in the cross-section, hold
down the Shift key, and then click all the other
shapes in the cross-section, including the 
mirror line.

9 Select the Mirror Curve tool and then click 
the mirror line.

TriSpectives duplicates the cross-section 
symmetrically on the other side of the mirror line’s 
axis.

10 Enclose the cross-section.
First, clean up your view of the cross-section by 
deleting the mirror line and the remaining 
construction lines, which are shown in dark blue. 
You still have two gaps to close. One is at the crotch 
of the claw and the other is outside the outer edges 
of the claw.
Address the latter gap first by dragging one of the 
red dots until it matches the other. The dots 
coalesce into a single green dot to show your 
success.
Next, use the Zoom Window tool to zoom in on the 
crotch of the claw. Select the Arc tool and create an 
arc to connect the two red points. Select the Arc tool 
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again to turn it off, and then drag the arc’s square 
handles until you have a smooth curve.
When you’re done, the cross-section should look like
the following illustration.

Finished cross-section for hole shape of hammerhead

11 To turn the cross-section into a 3D hole shape 
for the hammerhead, select Finish Shape in the 
Edit Cross-Section dialog box.

Creating the striking surface of the 
hammer
The last part of the hammer model is the striking 
surface. Unlike the first three shapes, you can drag this 
one out of the Shapes catalog and drop it on the model.

u To add the striking surface to the hammer model:
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1 Use the Orbit Camera and Look At tools to 
look straight at the front of the hammerhead.

2
3 Choose the Select tool and then choose the 

Edit IntelliShapes tool if it isn’t selected 
already.

3 Click the Shapes tab at the right of the 
TriSpectives window to see the items in its 
catalog.
If necessary, scroll through the catalog items to find 
the Cylinder shape.

4 Drag the Cylinder shape from the catalog and 
drop it on the hammerhead when a green dot 
appears.
This ensures that the striking surface is positioned in
the center of the hammerhead. If a green dot 
doesn’t appear, you can position the striking surface
later.

5 Change the dimensions of the cylinder shape 
to make it fit the model.
Use the shape’s Sizebox properties. Right-click the 
cylinder, select IntelliShape Properties from the pop-
up menu, and click the Sizebox tab. In the Sizebox 
properties sheet, enter the following values.
Height: 2 cm
Width: 3 cm
Length: 3 cm
Click OK when you finish.

If a green dot did not appear in Step 4 above, drag the 
striking surface along the surface of the hammerhead 
until it looks centered.
The hammer model now contains all its shapes. In the 
next two sections, you’ll add some finishing touches to 
make the hammer look more realistic.
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Beveling the striking surface
The striking surface needs rounded edges to make it 
look more like a hammer. To round the edges, apply a 
bevel to the starting and ending sections of the surface.

u To bevel the striking surface:
1 Select the Edit IntelliShapes tool if it isn’t 
already selected.
2 Right-click the striking surface and choose 

IntelliShape Properties from the pop-up 
menu.

3 Select the Bevel tab on the properties sheet.
The Bevel properties appear.

4 Choose the End Section Edges option.
This selection specifies which end of the shape you 
want to bevel.

5 Choose the Blend option and then type 0.2 as 
the blend radius for the ending section 
edge.

6 Choose the Start Section Edges option, choose
Blend again, and type 0.2 as the blend 
radius for the starting section edge.

7 Choose OK to close the properties sheet and 
see the beveled striking surface in the scene.

Adding colors and textures
To complete the hammer model, give the handle a 
shiny black finish and apply a steel finish to rest of the 
surfaces.

u To add colors and textures to the hammer:
1 Switch to Model mode.

If the Edit IntelliShapes tool or Edit Surfaces and 
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Edges tool is selected, click it off.
3 Click the Metals tab at the right of the 

TriSpectives window to see the items in its 
catalog.

2 Scroll through the catalog items, locate Steel, 
and drag it from the catalog onto the hammer.

4 Switch to Surfaces mode by selecting the Edit
Surfaces and Edges tool.

5 Scroll through the Surfaces catalog items, 
locate Shiny Black, and drag it from the 
catalog onto a surface of the hammer’s 
handle.
Repeat this step a few more times to apply the Shiny
Black finish to all surfaces of the handle. When you 
finish, the hammer looks like the following 
illustration.

Finished hammer model
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